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Abstract  

Forest fragmentation, which occurs when gaps are made in forests resulting in an increase in 

light, is an important topic in Forest Ecology.  Plants are sessile organisms and must be able to 

alter their morphology and physiology in response to changing light conditions. The crown of a 

tree consists of leaf-supporting branches extending from a main trunk axis.  The architecture of 

tree branches is, in part, dependent on light availability.  Trees can be categorized into shade 

tolerant and shade intolerant species, which alter crown architecture differently in response to 

light due to phenotypic plasticity.  The Yale -Myers Experimental Forest is a temperate 

deciduous forest where I conducted my study in which I asked (1) whether light from a gap 

promotes asymmetrical growth of tree crowns, (2) if the asymmetrical growth diminishes as a 

function of distance from the gap edge, and (3) if the response was species specific and related to 

a given species of shade tolerance.  I found that 19 trees in the study exhibited asymmetrical 

crown growth towards the gap.  There was an association between crown asymmetry and 

distance from the gap, with trees closer to the gap exhibiting more asymmetrical crown growth.  

When doing pairwise comparisons on each of the three distance groups (0-10m, 10-20m, and 20-

30 m), the only significant difference was at Tree Heaven between the 0-10 m and the 20-30 

group.  There was no association between shade tolerance and asymmetrical crown growth 

within 11 m from the gap.  The results of the study were not as expected given previous studies 

done on related topics, however this could have been due to the reduced sample size.  It is 

possible that, since my sample size was not large enough, there was not enough power to detect 

significant differences at the Yale -Myers Experimental Forest.  In future explorations, a larger 

sample size to yield more observations might prove to be prudent.    
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Introduction 

Trees can be grouped into climax (shade tolerant) species and pioneer (shade intolerant) 

species.  Shade tolerance is an ecological concept that refers to the capacity of a photosynthetic 

organism to tolerate varying light levels (Valladares and Niinemets, 2008).  Trees in these two 

classes of shade tolerance differ morphologically and physiologically, as well as in their response 

to environmental stress.  One such environmental stress, such as a sudden increase in light that 

occurs when a gap opens in the forest canopy, is an important aspect of forest ecology.  Light is 

an essential factor that influences survival and growth in photosynthetic organisms, and 

encourages competitive interactions in forest communities (Valladares & Niinemets, 2008).  

Survival of a tree in response to a forest canopy gap is dependent on how well it will tolerate 

light intensity and on its ability to acclimate to a sudden increase in light (Whitmore, 1989).  

Shade intolerant tree species require full sun to grow successfully in the forest understory while 

shade tolerant tree species are more likely to withstand less than ideal light conditions than shade 

intolerant trees (Delagrange, 2004; Clatterbuck, n.d.).   Much of the research on canopy gaps has 

focused on the photosynthetic response of leaves, however, crown architecture may vary in 

response to light (Coopman et al., 2011, see also Schultz, unpublished).    

Forest regeneration is the process of tree seedlings becoming established in a forest floor 

(Matija et al., 2015) and shade tolerance is a driving force behind forest succession (Keenshaw et 

al., 2006).   As seedlings and saplings, shade tolerant and shade intolerant trees grow at different 

rates.  The crown of the tree refers to the assemblage of leaf-supporting branches, as defined by 

Sterck and Bongers (2001).   Tree crowns are important in water transport and mechanical 

support of leaves and reproductive organs, and in part, crown architecture is dependent on the 

light available.  The crowns of shade tolerant and shade intolerant tree species differ due to 
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morphological and physiological differences between the two groups.  There are mechanical and 

physiological constraints on canopy recruitment for both shade tolerant and intolerant trees 

allowing for phenotypic differences when exposed to light (Canham, 1989). There is question as 

to whether shade tolerance or shade intolerance is more effective in altering crown architecture 

in response to light.  If species of shade tolerant or shade intolerant trees can take advantage of a 

gap, those species could influence their ability to regenerate more productively.  In this sense, 

shade tolerant or shade intolerant trees would put out more seeds, thus increasing individual 

fitness relative to the species that cannot take advantage of a gap.   This difference in fitness 

could influence the change of species community in a forest over time due to forest 

fragmentation and could be studied by examining the growth of shade tolerant and shade 

intolerant trees of reproductive age in response to a sudden increase in light, which is comparable 

in nature to forest fragmentation.  

Mourelle and Kwon (2000) studied light occlusion (the process of growing branches 

laterally to close a forest gap space and capture light) in shade tolerant and intolerant species 

along a gap edge in a temperate deciduous forest in the Carolinian Forest of southwestern 

Ontario, on the northern shore of Lake Erie.  They hypothesized that shade tolerant and shade 

intolerant tree species would also differ in their ability to occlude light, as increased light will 

likely result in modifications in crown architecture.  To test this hypothesis, they measured 

canopy closure and concluded that shade tolerant trees such as silver maple (Acer saccharinum) 

are more likely to alter their crown architecture by growing more branches towards the gap edge 

and subsequently obstruct light transmission, resulting in a more asymmetrical crown. 

At the Harvard Forest Long-Term Ecological Research (LTER), a mixed hardwood site 

in central Massachusetts, USA, Muth and Bazzaz (2002) hypothesized that an increase in light 
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availability would lead to the displacement of tree crowns and that this response would vary 

depending on species and tree size; finding that shade intolerant, early successional, tree species 

were more likely to exhibit crown displacement towards the gap and that shade tolerant, late 

successional, tree species were less likely to show this effect, contrary to Mourelle and Kwon’s 

(2000) results.   

Therefore, there is disagreement regarding crown expansion of canopy trees with respect 

to their level of light tolerance, posing an important question of whether shade tolerant or shade 

intolerant tree species are more likely to respond to a sudden increase in light availability.  

Additionally, I am not aware of any other study on the effect of light availability in southern 

New England deciduous forests.  I examined if the crowns of shade tolerant canopy trees grew 

asymmetrically - in the direction of two artificially created gaps - more than those of shade 

intolerant trees or vice versa, given the inconsistency in the literature. 

  Sterck & Bongers, (2001) found that crown growth and expansion decreased in areas of 

decreased light availability and they suggested that the effect of light on crown growth is not as 

prevalent deep in the forest than it is near a forest gap.  To account for the response of light 

further away from the gap, four randomly selected transects in each of two gap sites were used in 

this study.  The Yale-Myers Forest is mixed temperate deciduous and the major tree genera are 

Betula (birch), Fagus (beech), Quercus (oak), and Acer (maple) (Nuñez & de Gouvenain, 2015), 

which vary with respect to their shade tolerance.  Maple and beech species are shade tolerant, 

oak species are intermediately tolerant, while birch is shade intolerant (Department of Forest 

Ecology and Management, 1996).  

I asked the following questions: (1) Does additional light from a gap promote the 

asymmetrical growth of tree crowns? I hypothesized that the gap will cause the trees to grow 
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their crown away from their trunk main axis and towards the gap to capture the excess light 

made available by the removal of neighboring trees in the gap. The null hypothesis for this 

question is that the tree crowns will not display asymmetry.  (2) If crowns did respond to the 

creation of a gap, does that effect diminish as a function of distance from the gap edge? I 

hypothesize that trees that are closer to the gap would exhibit more asymmetrical crowns than 

trees further into the forest.  The null hypothesis would be that tree crowns, regardless of 

distance from the gap, would exhibit the same amount of crown symmetry or asymmetry. (3) If 

there is asymmetrical crown response, is that response species-specific and related to a given 

species shade tolerance?  Due to the current lack of agreement on the response of shade tolerant 

and shade intolerant tree species in response to a gap, I hypothesize that crown response to a gap 

is different between shade tolerant and intolerant species, without directional hypothesis for 

which of the two would respond more or less.     The null hypothesis would be that there is no 

difference in crown architecture between shade tolerant and shade intolerant.  With this study, I 

hope to contribute to resolving the lack of agreement among past studies.   

Previous methods to measure the canopy structure of adult trees analyzed the number of 

branches per tree, cut down the branches, or measured leaf weight per volume (Mourelle & 

Kwon, 2000; Niinemets & Kull, 1995).  These methods are time consuming and detrimental to 

the health of the plant, and thus would not be allowed at the Yale -Myers Forest.   Instead, I took 

photos of the canopy of each tree, converted them to binary (black and white pixels only), and 

then compared the number of black pixels on the gap side versus the forest side as a way of 

determining which tree crowns were more displaced towards the gap.  This process was quicker 

than measuring and counting the branches from each tree and less destructive than physically 

cutting the branches from the trees.    
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Muth and Bazzar (2002) reported that coniferous trees exhibited a relatively fixed 

architecture with smaller lateral branches and a well formed, developed trunk, and therefore 

proposed that conifer crowns would exhibit less flexibility in their allocation for resources.  The 

same authors found that coniferous trees did not respond to increased light by displacing their 

crowns towards a gap. Umeki (1995) reported similar findings in a study on crown displacement 

in Picea abies (Norway spruce; a conifer) compared to Betula maximowicziana (Monarch birch; 

an angiosperm).  The study concluded that spruce exhibited low values for canopy displacement 

as compared to birch.  Getzin & Wiegand (2007) determined that angiosperms were more 

asymmetrical in their crown patterns than gymnosperms, and thus would likely show more 

asymmetrical changes in crown architecture in response to increased light.   Considering the 

consensus from the literature that the crown of coniferous species is not likely to respond to 

change in light levels, I did not include coniferous tree species in this study.  Sterck and Bongers 

(1998) state that saplings are not a good model for looking at crown architecture as they are not 

fully developed.  Therefore, I only included canopy trees (those that have grown tall enough to 

have their crowns within the forest canopy) in my study as opposed to seedlings or saplings 

whose crowns were in the understory of the forest.   

 

Methods  

Study site 

This study was conducted in the Yale-Myers Experimental Forest in Eastford, 

Connecticut (41° 56’N, 72°7’W, elevation 200 m) (Nunez, 2014). In the winter of 1999-2000, 

two 100 m x 20 m experimental large gaps (ELG’s) were artificially created by the Yale School 

of Forestry and Environmental Studies (YSFES) by removing all above ground plants at Kozey 
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Road and Tree Heaven study sites.  Using methodology similar to that of McDonald and Urban 

(2004), four 30 m x 10 m belt transects were randomly located in 2007 by the RIC Forest 

Ecology Lab at each ELG, and I used these transects for my study (Fig. 1).   

   

 
Figure 1. Transect layout of the ELGs at the Yale-Myers experimental forest.  Trees within 5 m 
on either side of each transect line (shown by the center line of each vertical rectangle) were used 
for the analysis. The trees used in this study were tagged previously in 2007 and 2009.  

 

Field Methods 

For each tree located within the belt transects, the diameter at breast height (dbh) in 

centimeters (cm) was measured approximately 1.5 meters above ground.  If the tree dbh in 2016 

was equal to or less than the dbh of the same tree measured in 2007 or 2009 by other RIC Forest 

Ecology Lab research students, it was considered dead and was not used in this study.  In the 

winter of 2015-2016 (when deciduous tree crowns were devoid of leaves), I used a Nikon D 40 

camera to take tree crown photographs with the lens’s focal length set to 55 mm, focus set on 

automatic, and the flash turned off. Starting at the gap edge and going 30 meters into the forest, 
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two photos were taken of the crown of each tree tagged in 2007 and 2009 that had a dbh of 10 

cm or greater from the east and west sides of the trunk (as pseudoreplicates to increase my 

confidence level when doing the image analyses).  Pressing my belly to the trunk of the tree with 

the bottom of the camera facing the trunk, the viewfinder was positioned so that the tree trunk 

was centered along the bottom side of the picture.  Additionally, the junction between the trunk 

and the branches was positioned as close to the center of the photo as possible.   

 

Data analysis 

Both east side and west side crown photos for each tree were uploaded to ImageJ, an 

open source image processing program developed at the National Institute of Health, 

transformed into binary (black/white pixels) images, and cut in half to create two equal halves, 

one half capturing the crown half on the gap side of the crown midpoint, and the other the crown 

half on the forest side. I analyzed the area of the image covered by branch and trunk pixels 

(black pixels) and compared the number of black pixels on the north side (forest-facing 

branches) and the south side (gap-facing branches) of a given tree crown (Fig. 2).    

 

Figure 2.  The photos from the east and west side of each tree were cut in half to show north 
facing and south facing branches.   
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Figure 3. Photo analysis of crown architecture.  (a) depicts an example of a tree that displays 
crown asymmetry.  This tree was 10.3 meters from the gap.  This photo was taken from the west 
and cut in two halves to yield a forest side (left) and a gap side (right).  (b) shows a photo of a 
symmetrical crown of a tree located 24.7 m from the gap edge taken from the east to yield a gap 
side (left) and forest side (right). Branch and trunk pixel area towards the gap were compared to 
branch and trunk pixel area towards the forest.  

 

Photos taken in the field had extraneous tree branches from surrounding trees that were 

not used in my analyses. Therefore, in ImageJ, I used the eraser to remove those extraneous 

trunks and branches to eliminate noise as much as possible (see Appendix A for details on the 

ImageJ crown photo transformation and analysis).  Figure 3 depicts photos that had the majority 

of background noise eliminated, and are representative of the photos that were used in all my 

photo analyses.   

 

Tree Crown Photo Analysis  

Hypothesis 1. Tree asymmetry 

  I first tried a 2x2 χ2 contingency table analysis, using north vs. south as the predictor 

variable and black vs. white pixels as the response variable to determine whether tree crowns 

exhibited asymmetry.  However, since the photos were comprised of 30,000 to 80,000 pixels, the 

a	 b	
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contingency table cell values were extremely high and increased the probability of Type I error, 

making that χ2 statistics significant, regardless of whether the photo was of a clearly 

asymmetrical or clearly symmetrical tree crown (Fig. 3 a and b).   

An image has three dimensions; hue, or color; chroma, or saturation intensity; and value, 

the brightness of the photo, so when I converted the images to binary, the pixel values were not 

strictly black or white but assigned by ImageJ to a value on a grayscale of pixel values ranging 

from pure black (0) to pure white (255).  (https://imagej.nih.gov/ij/docs/guide/146-29.html).   

I was asking whether the crown was asymmetrical towards the gap, so I compared the 

pixels up to value 127.  By dividing the highest pixel gray scale value (255) by two, I got 127, 

and designated this pixel value as the cutoff between black and white pixels. Tree and branch 

pixels were black and the background was white.  Mann-Whitney U tests were calculated to 

compare the black pixel gray scale values between the north side and the south side of the two 

images from each side of each tree (Appendix B). For some trees, Mann-Whitney U test results 

were clearly not realistic and I found that it was because the trunks of some of the photos were 

not centered exactly in the middle of the photo, as I had assumed previously.  

Despite my best attempt at keeping the trunk at the center of the bottom edge of the 

photograph when taking the photos in the field, some tree trunks ended up not being positioned 

exactly so, therefore using the preexisting ImageJ macro system to split the photos in half did not 

work.  Each photo uploaded to ImageJ consisted of x and y coordinates that could be used to 

determine the exact location of the left and right bottoms of the tree trunk (Appendix A).  Using 

those two coordinates, I determined the middle of the tree by adding the two coordinates together 

and dividing by 2.  The photo was then cropped vertically at that location.  The photos were 3000 

pixels across.  If the center of the photo was less than 1,500, then the right photo had more pixels 
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than the left and the right photo was cropped again to ensure that both halves had the same 

number of pixels.  If the center was greater than 1,500 then the same was done to the left half of 

the photograph.   

Because the χ2 contingency table and the Mann-Whitney test were always significant at 

the 0.05 alpha level regardless of branching pattern, I hypothesized that the pixel size was too 

small, making the pixel sample size far too large (30,000 to 80,000 black pixels per half-photo 

on average), which resulted in artificially increasing the probability of making a Type I error 

when carrying out a χ2 or a Mann-Whitney test. By increasing the pixel size, I reduced the 

number of pixels in each half photo from 6 million pixels to 176, a sample size that is less likely 

to increase the probability of making a Type I error (See Appendix D on methodology for 

enlarging pixel size).  Analyzing the photos with this larger pixel size, the χ2 2 x 2 contingency 

table tests, set up the same as previously stated, and the Mann-Whitney tests, yielded results that 

were reasonable given how symmetrical or asymmetrical each photo was.  If the east half and the 

west half images p-values of a given tree crown were both either significant or non-significant, 

then that particular tree data were used for further analyses.  If the east vs. west p-values did not 

match for the two sides of a given tree, then that particular tree was left out of further analyses.   

 

Hypothesis 2.  Asymmetry vs. distance from gap edge 

Next, to investigate how far into the forest tree crowns exhibited asymmetry, a Kruskal-

Wallis test was done to compare Mann-Whitney values for each tree among three groups: trees 

from 0 m to 10 m, 10 m to 20 m, and 20 m to 30 m into the forest (coded 1, 2, and 3, respectively 

in some tables in the Results section of this study) (See Appendix E on methodology for 

computing the Kruskal-Wallis test in SPSS).  Trees that showed Mann-Whitney p-values that 



 Godfrey  15 

were less than or equal to 0.05 for both the east and west side photos, or both greater than 0.05 

for both the east and west side photos, were used in the analysis.  To test whether trees closer to 

the gap edge were more likely to have an asymmetrical crown, a linear regression was done to 

analyze the relationship between distance from the gap and Mann-Whitney statistic values for 

each tree for each ELG site (Appendix F for methodology in SPSS). 

 

Hypothesis 3. Shade tolerant vs. shade intolerant species  

Lastly, I used the Mann-Whitney test statistic values I calculated for each tree used to test 

Hypothesis 2 to determine if shade tolerant or shade intolerant trees were more likely to respond 

to light by altering their crown towards the gap.  For this analysis at both ELGs, intermediately 

tolerant trees were grouped in with shade intolerant tree species because, at the Yale forest, the 

most interesting species contrast is between oaks (intermediately shade tolerant) and maples 

(shade tolerant).   Tree species found at each ELG with corresponding shade tolerance levels can 

be found in Table 1.  

For Kozey Road and Tree Heaven, I conducted χ2 2 x 2 contingency table tests and 

logistic regressions for trees within 11 meters (to include a few oak trees just beyond the 10 m 

mark) from the gap comparing shade tolerant and shade intolerant crown asymmetry.   The 

logistic regression modelled shade tolerance, a binary dependent variable, against Mann-Whitney 

statistic values, the continuous predictor.  For the χ2 2 x 2 contingency table tests, the predictor 

was shade tolerance, and the response was significant Mann-Whitney vs. or nonsignificant 

Mann-Whitney values. Logistic regressions for Kozey Road, Tree Heaven, and both ELGs 

pooled data were done using Mann-Whitney statistic east and west averages.  Following the χ2 
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analysis, I conducted a Fisher’s exact probability test as a check because some of the χ2 2 x 2 

contingency table cell values were < 5. 

   

 

Table 1. Tree species found at Kozey Road and or Tree Heaven and their shade tolerance level.  

Tree code Species Common name Tolerance level 

ACRUBOTH* Acer rubrum Red maple Tolerant  

ACSABOTH Acer saccharum Sugar maple Very Tolerant 

BEALKR Betula alleghaniesis Yellow birch Intermediate 

BELETH Betula lenta Black birch Intolerant 

BEPOKR Betla populifolia Gray birch Intolerant  

CACAKR Carpinus caroliniaina American hornbeam Tolerant 

CAGLKR Carya glabra Pignut hickory Intermediate (intolerant in northeast) 

CAOVKR Carya ovata Shagbark hickory Intermediate 

CATOKR Carya tomentosa Mockernut hickory Intolerant  

FRAMKR Fraxinus americana White ash Intolerant 

PISTTH Pinus strobus Eastern white pine Intolerant 

QUALKR Quercus alba White oak Intermediate 

QURUBOTH Quercus rubra Northern red oak Intermediate 

QUVETH Quercus velutina Black oak Intermediate 

TSCABOTH Tsuga canadensis Eastern hemlock Very Tolerant 

* KR = species found at Kozey Road only, TH = species found at Tree Heaven only, BOTH = 
species found at both ELGs 
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Results 

Hypothesis 1. Tree asymmetry 

Histograms of pixel gray scale values for each photo ranged from 0 (black) to 255 

(white).  Tables 2 and 3 show p-values for trees that had east and west photos. At Kozey Road, 

53 trees were inventoried and used for the Mann-Whitney analysis.  I compared the 

pseudoreplicated east side and west side photo black pixels p-values and discarded any tree that 

had mismatched east side and west side photo Mann-Whitney black pixels p-value.  As a result, 

16 trees were discarded, leaving 37 trees for further analysis.  Of these 37 trees, 12 had north vs. 

south-facing crown pixel p-values that were significant, meaning 12 of the trees exhibited 

asymmetrical growth, mostly towards the gap.  However, two of the trees (trees 11 and 16 in 

transect 3) exhibited asymmetrical growth away from the gap (toward the forest).   

At Tree Heaven, 38 trees were inventoried and used for the Mann-Whitney analysis.  Of 

those 38 trees, 13 had mismatched pseudoreplicated east/west Mann-Whitney p-values that I 

discarded, leaving 25 trees with matching pseudoreplicated east/west Mann-Whitney p-values to 

be used for further analyses.  Seven of these showed asymmetrical crown growth with 2 of these 

trees (tree 20 in transect 5 and tree 6 in transect 12) showing asymmetrical growth away from the 

gap.  To validate the results of the Mann-Whitney tests, χ2 2 x 2 contingency tables were 

constructed, using north and south as the predictors and black and white pixel values as the 

response.  One value for the black pixel distribution was obtained by adding up all pixels below 

the cutoff of value 127.   The same was done for white by adding up all pixels from values 128 to 

255.   When the Mann-Whitney test showed significant asymmetrical growth from both the east 

and west photos, that three also showed a significant χ2 value as well (Table 2, Table 3).   
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Table 2. Data for Hypothesis 1.  Mann-Whitney statistics, χ2 statistics, and p-values for trees at 
Kozey Road for east side (E) and west side (W) crown photos.  Trees are ordered by transect 
number, then by distance from the gap.     

Transect    
/ tree# 

distance   
from  gap (m) 

Species MannWhitney  
Statistic E 

P value Mann-
Whitney E 

MannWhitne
y  Statistic W 

P value Mann-
Whitney W 

χ2 value E χ2 p value E χ2 value 
W 

χ2 p value W 

301 0.96 ACSA 5013.5 0 6200.5 0 32.4 p<0.01 11.26 p<0.01 

304 6.3 CAGL 7880 0.448 8182.5 0.98 0.53 p>0.05 0.078 p>0.05 

308 6.4 ACSA 7503.5 0.045 5752.5 0 0.016 p>0.05 31.32 p<0.01 

309 6.7 ACSA 6691.5 0 6087.5 0 19.56 p<0.01 20.04 p<0.01 

310 7.7 ACSA 8058 0.725 7916.5 0.404 1.02 p>0.05 10.83 p<0.01 

311* 8.7 ACSA 7082.5 0.005 5801.5 0 0.12 p>0.05 76.16 p<0.01 

307 9.4 ACRU 8129 0.842 7813.5 0.265 0.637 p>0.05 1.49 p>0.05 

315 13.1 FRAM 8083.5 0.756 8064.5 0.67 0.2 p>0.05 0 p>0.05 

316* 13.2 QUAL 7673.5 0.156 8016 0.589 6.04 0.01<p<0.05 0.68 p>0.05 

323 24.7 ACSA 8039.5 0.676 8067 0.738 0.64 p>0.05 0.02 p>0.05 

503 5 ACSA 7881 0.414 7922.5 0.495 18.42 p<0.01 0.06 p>0.05 

504 6.1 BEAL 6590 0 7229.5 0.009 26.94 p<0.01 15.4 p<0.01 

507 10.3 QUAL 7114 0.019 5894 0 2.68 p>0.05 36.12 p<0.01 

508 10.6 ACSA 5136 0 5552 0 84.26 p<0.01 65.86 p<0.01 

510 12.2 ACSA 8033 0.692 7465 0.063 0.02 p>0.05 3.94 0.01<p<0.05 

513 19.6 QUAL 6965 0.001 7116 0.003 20.66 p<0.01 4.9 0.01<p<0.05 

515 22.7 ACSA 7796.5 0.279 7867 0.357 1.5 p>0.05 0.1 p>0.05 

518 25.1 ACSA 8136 0.859 7726.5 0.127 0.1 p>0.05 3.44 p>0.05 

519 27.6 ACSA 7614.5 0.093 7687 0.158 24.74 p<0.01 5.78 0.01<p<0.05 

802 2.2 CAOV 7007 0.002 6369.5 0 19.98 p<0.01 13.96 p<0.01 

809 4.8 BEAL 7808 0.199 7750.5 0.101 0.8 p>0.05 0.62 p>0.05 

804 5.2 BEAL 7424 0.008 7808 0.031 12.9 p<0.01 20.36 p<0.01 

807 9.2 CAOV 7889 0.439 8094.5 0.802 8.64 p<0.01 0.22 p>0.05 
808 12.4 BEAL 7620 0.088 8129 0.83 1.98 p>0.05 3.1 p>0.05 

814 18.2 CAOV 7886.5 0.375 7932.5 0.457 1.36 p>0.05 1.46 p>0.05 

811** 18.4 CACA 6961 0 - - 6.06 0.01<p<0.05 - - 

813 19.6 QUAL 7460.5 0.078 7570 0.121 0.06 p>0.05 1.42 p>0.05 

818 26.5 BEAL 7936 0.238 8064.5 0.681 4.84 0.01<p<0.05 0.14 p>0.05 

1201 1.3 ACSA 7221.5 0.005 7196 0.003 10.4 p<0.01 12.1 p<0.01 

1204 3.7 ACSA 7672 0.082 8061 0.598 5.24 0.01<p<0.05 4.32 0.01<p<0.05 

1206 7.6 ACSA 7920.5 0.425 7667 0.112 0.7 p>0.05 5.96 0.01<p<0.05 

1207 9.2 ACSA 7567 0.126 8079.5 0.78 1.72 p>0.05 0.02 p>0.05 

1210 17.1 ACSA 8049.5 0.69 7625.5 0.154 0.1 p>0.05 8.28 p<0.01 

1211 19.1 CATO 8129 0.851 8005 0.577 0.1 p>0.05 0.2 p>0.05 

1213 22.5 CACO 8053.5 0.691 8149 0.907 0.32 p>0.05 0.18 p>0.05 

1212 23.1 QUAL 8132.5 0.859 7549 0.078 2.28 p>0.05 0.1 p>0.05 

1214 23.3 ACSA 7730 0.19 7667.5 0.123 10.1 p<0.01 1.24 p>0.05 

* indicates crown asymmetry leaning towards the north and was therefore excluded from the Kruskal-Wallis test 
** The west side photo taken of tree 11 of transect 8 was not included in the study due to too much background noise in the photo that was not 
able to be removed during the image analysis 
Figure legend: ACRU = Acer rubrum, ACSA = Acer saccharum, BEAL = Betula alleghaniesis, BELE = Betula lenta, BEPO = Betula 
populifolia, CACA = Carpinus caroliniaina, CAGL = Carya glabra, CAOV = Carya ovata, CATO = Carya tomentosa, FRAM = Fraxinus 
americana, PIST = Pinus strobus, QUAL = Quercus alba, QURU = Quercus rubra, QUVE = Quercus velutina, TCSA = Tsuga canadensis  
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Table 3. Data for Hypothesis one.  Mann-Whitney, χ2 statistics, and p-values for trees at Tree 
Heaven for east side (E) and west side (W) crown photos.  Trees were organized by transect 
number, then by distance from the gap.     

Transect/     
tree# 

distance 
from 
gap(m) 

Species MannWhitney  
Statistic E 

P value 
Mann-
Whitney E 

MannWhitney  
Statistic W 

p-value Mann-
Whitney W χ2 value E χ2 p-value E χ2 value W χ2 p-value W 

202 2.5 QUVE 6767.5 0.001 6810.5 0.002 25.02 p<0.01 7.84 p<0.01 

203 3.72 QURU 7789 0.27 7777.5 0.246 0.08 p>0.05 5.9 0.01<p<0.05 

204 5.64 QUVE 7969.5 0.547 7827 0.328 0.7 p>0.05 1.26 p>0.05 

206 10.3 ACRU 7840.5 0.406 8089.5 0.798 1.4 p>0.05 1.47 p>0.05 

211 25.71 ACRU 7750 0.147 7949 0.448 2.88 p>0.05 3.24 p>0.05 

212 26.45 QURU 8114.5 0.857 8015.5 0.652 0.88 p>0.05 2.4 p>0.05 

505 5.54 ACRU 7028.5 0.004 6498.5 0 41.04 p<0.01 19.32 p<0.01 

504 8.27 ACSA 7942 0.534 7801 0.338 1.36 p>0.05 0.62 p>0.05 

507 10.85 QURU 7721.5 0.213 7576.5 0.146 2.02 p>0.05 2.06 p>0.05 

510 14.12 QUVE 7994 0.599 7682 0.204 1.7 p>0.05 2.3 p>0.05 

512 16.69 QURU 5847.5 0 6616 0 30.18 p<0.01 30.18 p<0.01 

516 21.75 QURU 8050 0.667 8049.5 0.683 1.3 p>0.05 0.84 p>0.05 

519 27.18 ACSA 8157 0.931 7701.5 0.165 4.14 0.01<p<0.05 11.8 p<0.01 

520* 29.43 BELE 6157 0 6532 0 9.32 p<0.01 22.94 p<0.01 

901 2.8 BELE 8117.5 0.858 8091.5 0.778 1.64 p>0.05 1.02 p>0.05 

902 5.25 QURU 6649 0 7363 0.041 11.54 p<0.01 1.94 p>0.05 

906 9.1 BELE 7412 0.009 7229 0.002 13.74 p<0.01 26.6 p<0.01 

913 22.95 ACRU 7874 0.297 8068.5 0.715 1.74 p>0.05 0.1 p>0.05 

914 23.1 ACRU 7799.5 0.235 8075 0.723 4.32 0.01<p<0.05 3.64 p>0.05 

1206* 13.3 QURU 6604 0 6275 0 4.85 0.01<p<0.05 36.86 p<0.01 

1208 15.95 ACSA 8129 0.858 8032 0.712 0.108 p>0.05 10.24 p<0.01 

1210 19.4 QURU 7977.5 0.522 7613 0.075 0.38 p>0.05 9.20 ** p<0.01 

1211 20.5 QURU 7805 0.327 7943 0.464 1.26 p>0.05 1.4 p>0.05 

1212 20.6 QURU 8137 0.874 8183 0.979 0.2 p>0.05 1.36 p>0.05 

1216 25.3 ACRU 8131 0.866 7749 0.221 1.36 p>0.05 6.04 0.01<p<0.05 

* indicates crown asymmetry leaning towards the north and was therefore excluded from the Kruskal-Wallis test 
**indicates a value that was significant in the north direction, however χ2 statistics were not utilized in the Kruskal-Wallis test, 
and so was not excluded from the study 
Figure legend: ACRU = Acer rubrum, ACSA = Acer saccharum, BEAL = Betula alleghaniesis, BELE = Betula lenta, BEPO = Betula 
populifolia, CACA = Carpinus caroliniaina, CAGL = Carya glabra, CAOV = Carya ovata, CATO = Carya tomentosa, FRAM = Fraxinus 
americana, PIST = Pinus strobus, QUAL = Quercus alba, QURU = Quercus rubra, QUVE = Quercus velutina, TCSA = Tsuga canadensis  
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Hypothesis 2. Asymmetry vs. distance from gap edge 

The Kruskal-Wallis test comparing the three distance groups (0 to 10 m, 10 to 20 m, and 

20 to 30 m from gap edge), revealed a significant difference among groups at Tree Heaven (p-

value=0.004) but not at Kozey Road (p-value=0.060) (Table 4).   

 

Table 4. Kruskal-Wallis results for (a) Kozey Road and (b) Tree Heaven.   

 

 

 

Since the Kruskal-Wallis test was significant at Tree Heaven, I wanted to see which of 

the three distance groups differed from each other in terms of crown asymmetry, so I did three 

pairwise Mann-Whitney tests to compare each of the three groups to one another (1 to 2, 2 to 3, 

and 1 to 3) at each ELG (Table 5).  This was in lieu of a post hoc test, which was not available in 

SPSS for nonparametric ANOVA analogs such as Krsuskal-Wallis.  I therefore used a 

Bonferroni correction by dividing the typical alpha level (0.05) by the number of pairwise 

a	 b	



 Godfrey  21 

comparisons (3) to yield a new alpha level of 0.0167.   For each ELG, pairwise tests yielded the 

following results: 0-10 m vs. 20-30 m contrast (p-value=0.015 for Tree Heaven, p-value=0.238 

for Kozey Road), groups 10-20 m vs. 20-30 m contrast (p-value=0.113 for Tree Heaven, p-

value=0.395 for Kozey Road), and 0-10 m vs. 10-20 m contrast (p-value=0.662 for Tree Heaven, 

p-value=0.716 for Kozey Road).   I created scatterplots of Mann-Whitney statistic values as a 

function of distance from the gap (Fig. 4, Fig. 5). The linear regression yielded a significant 

relationship between distance from the gap and Mann-Whitney values for Kozey Road (slope 

coefficient p-value=0.020), but not for Tree Heaven (slope coefficient p-value=0.056) (Table 6, 

Table 7).  
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Table 5. Data for Hypothesis 2.  Mann-Whitney statistics for Kozey Road and Tree Heaven 
grouped by distance from the gap edge.   

code* Kozey 
Road 

Tree 
Heaven code* Kozey 

Road 
Tree 
Heaven code* Kozey 

Road 
Tree 
Heaven 

1 5013.5 6767.5 2 8083.5 7840.5 3 8039.5 7750 
1 7880 7789 2 7114 7721.5 3 7796.5 8114.5 
1 7503.5 7969.5 2 5136 7994 3 8136 8050 
1 6691.5 7028.5 2 8033 5847.5 3 7614.5 8157 
1 8058 7942 2 6965 6604 3 7936 7874 
1 8129 8117.5 2 7620 8129 3 8053.5 7799.5 
1 7881 6649 2 7886.5 7977.5 3 8132.5 7805 
1 6590 7412 2 6961 8089.5 3 7730 8137 
1 7007 6810.5 2 7460.5 7576.5 3 7867 8131 
1 7808 7777.5 2 8049.5 7682 3 7726.5 7949 
1 7424 7827 2 8129 6616 3 7687 8015.5 
1 7889 6498.5 2 8064.5 6275 3 8064.5 8049.5 
1 7221.5 7801 2 5894 8032 3 8149 7701.5 
1 7672 8091.5 2 5552 7613 3 7549 8068.5 
1 7920.5 7363 2 7465 --- 3 7667.5 8075 
1 7567 7229 2 7116 --- 3 --- 7943 
1 6200.5 --- 2 8129 --- 3 --- 8183 
1 8182.5 --- 2 7932.5 --- 3 --- 7749 
1 5752.5 --- 2 7570 --- 
1 6087.5 --- 2 7625.5 --- 
1 7916.5 --- 2 8005 --- 
1 7813.5 ---    
1 7922.5 ---    
1 7229.5 ---    
1 6369.5 ---    
1 7750.5 ---    
1 7808 ---    
1 8094.5 ---    
1 7196 ---    
1 8061 ---    
1 7667 ---    
1 8079.5 ---    

*1 = trees within 0 to 10 m from the gap; 2 = trees within 10 to 20 m; 3 = trees within 20 to 30 m  
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The scatterplot of Mann-Whitney values versus distance from the gap at Tree Heaven 

indicated the presence of a potential outlier (Fig. 5).  Therefore, the linear regression was 

replicated omitting tree 516 at Tree Heaven, which was almost 20 meters from the gap, and yet 

exhibited an asymmetrical crown when others didn’t.  The tree was a red oak (Quercus rubra), 

which is intermediately tolerant.  This second regression model yielded a significant relationship 

between Mann-Whitney value and distance from the gap (p=0.008) (Table 7).   

 

Table 6. SPSS output for the ANOVA comparing the three distance groups at Kozey Road. 
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Figure 4.  Scatterplot of Mann-Whitney values as a function of distance from the gap at Kozey 
Road.  
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Table 7. SPSS output sheet for ANOVA comparing the three distance groups for Tree Heaven 
(A) shows the output with all data points present and (B) shows the output omitting the outlier. 
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Figure 5.  Scatterplots of Mann-Whitney values as a function of distance from the gap at Tree 
Heaven. (a) included all trees analyzed in the ELG and (b) removed one tree that was a potential 
outlier.   

 

Hypothesis 3.  Shade tolerant vs. shade intolerant species  

The logistic regression model of the relationship between shade tolerance and Mann-

Whitney statistics (Fig 6) showed no significant differences between shade tolerant and shade 

intolerant trees (p=0.417 for Kozey Road, p=0.876 for Tree Heaven, and p=0.345 for pooled data 

from both ELGs).  For Tree Heaven, the 2 x 2 χ2 contingency table analysis showed a significant 

difference between shade tolerant and shade intolerant trees within 11 m from the gap (χ2=4.13; 

p = 3.84), using tolerance as the predictor and significance as the response. There was a 

significant difference at Kozey Road between shade tolerant and shade intolerant trees for 0 to 

11 m from the gap (χ2=16.06; p = 6.64). When Tree Heaven and Kozey Road data were pooled 

for 0 to 11 m, the results were significant as well (χ2=8.98; p = 6.64).  However, because 2 x 2 χ2  

contingency tables are typically used for frequency data with realistically small cell values and 

the Mann-Whitney cell values were not frequencies and were large numbers, I decided to 

conduct a Fisher’s Exact Test with cell values being the number of trees in each category rather 

a	 b	
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than Mann-Whitney statistics, using shade tolerance as the predictor, and the number of trees that 

were either significant or nonsignificant as the response. The results of the Fisher’s exact 

probability test were not significant (p = 0.48 for Tree Heaven, p = 0.35 for Kozey Road, and p = 

0.28 for Kozey Road and Tree Heaven pooled data).  

 

Table 8. Logistic Regression output for (a) Kozey Road, (b) Tree Heaven, and (c) pooled.   
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 Figure 6. Logistic Regression graph for Tree Heaven trees within 30 m of the gap.  Mann 
Whitney values (corresponding to significance level of crown asymmetry) are on the x-axis, with 
the histograms denoting probability on the left and frequency on the right (of a given tree being 
either tolerant (1) or intolerant (0)). The slope of the logit model (red line) was not significant 
(p=0.876), indicating no significant difference in crown asymmetry between shade tolerant and 
shade intolerant tree species within 30 m from the gap (graph courtesy Dr. de Gouvenain). 

 

Discussion 

I investigated whether crown architecture responds to light availability created by two 

artificial gaps at two ELG sites in a southern New England forest by using tree crown 

photographs to compare the north- and south-facing branches of tree crowns.  At Kozey Road, 

12 of the 53 trees inventoried showed asymmetrical crown growth towards the gap, and at Tree 

Mann Whitney statistic value 
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Heaven, 7 of the 38 trees inventoried showed asymmetrical crown growth towards the gap.  This 

indicates that at least some trees responded to an increase in light by growing branches towards 

the gap.  These results agree with previous studies that show that canopy trees will extend their 

branches and alter crown architecture in response to a gap (Mourelle & Kwon, 2000; Umeki, 

1995).  Seventy-two trees total showed no asymmetry, which is consistent with Sterck and 

Bongers (2001) who found that light availability was not correlated with whole crown 

architectural changes. 

In a previous study done by Sterck and Bongers (2001), it was concluded that trees not 

exposed to intense light availability were characterized by slow crown growth, indicating that 

they were not responding to a forest gap.  I conducted linear regressions to test the relationship 

between Mann-Whitney statistic values and distance from the gap to observe how distance from 

a gap and light source affected crown asymmetry.  These regressions showed a relationship 

between the two variables.  While the pairwise Mann-Whitney analyses were significant only 

when comparing the distances 0-10 m with 20-30 m from the gap at Tree Heaven, the linear 

regression analyses showed that Mann-Whitney statistic values and distance from the gap were 

associated.  At the 0.05 alpha level, the linear regression for Kozey Road showed that there was a 

relationship between distance from the gap and Mann-Whitney values.  At the 0.10 alpha level, 

the regression for Tree Heaven showed that there was a relationship between distance from the 

gap and Mann-Whitney values.  When removing the outlier from the dataset at Tree Heaven, the 

relationship proved to be stronger as it was significant at the 0.05 alpha level.  From this data, I 

concluded that the trees that were closer to the gap were more likely to alter their crown 

architecture towards the gap.  Mann-Whitney values were generally lower closer to the gap than 

they were 20 to 30 m into the gap, which indicates those trees exhibited a more asymmetrical 

crown as lower Mann-Whitney values correlate with more significant p-values.   
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None of the logistic regressions were significant, which indicates that the response of 

crown architecture to gap creation is not a significant predictor of whether a tree is a shade 

tolerant species or not.  One assumption of logistic regressions is the requirement large sample 

sizes, so it is possible that my dataset was not large enough to detect a significant difference at 

the 0.05 alpha level.  The Fisher’s exact probability test results showed that shade tolerant trees 

were not significantly different form shade intolerant trees with respect to crown asymmetry, 

which does not concur with the results of the χ2 test.  The dataset I used pushed the boundaries of 

the assumptions of the χ2 test.  Cells of a 2 x 2 χ2 contingency table are typically populated with 

frequency data (the number of observations in a given category).  In my case, I used Mann-

Whitney statistic averages instead of frequency, and had the same problem that resulted in my 

not using the χ2 on the normally sized pixel values from the first hypothesis.  As a result, the 

pixel numbers in each cell were so high that the χ2 statistic was always higher than the critical 

value at the 0.05 alpha level, and I believe that was the case for the shade tolerance χ2 analysis.  

The  Fisher’s exact probability test was a more scientifically valid test given the dataset.  The 

results of this test override the results of the χ2, as the assumptions of the Fisher’s test are not 

invalidated.   The results were not as I had expected, since the χ2 analysis showed that the 

average Mann-Whitney statistic for shade tolerant trees was lower and therefore more 

significantly asymmetrical than shade intolerant trees.  However, it is possible that, due to my 

reduced sample size, I did not have enough power to detect a significant difference between 

shade tolerant and shade intolerant trees.  

While I started out with an adequate sample size for each ELG, the process of removing 

trees that had too much noise resulted in a sample size that was smaller than first anticipated.  

Removing trees that did not have matching north and south Mann-Whitney p-values also resulted 

in a reduction of data points used in the analysis.  Then, grouping each tree by distance cut the 
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sample size of each group by two thirds.  To compare shade tolerant and shade intolerant tree 

species, I divided each tree into shade tolerant or shade intolerant groups. These steps, while 

necessary to answer the questions I had proposed, resulted in a sample size that was potentially 

too small to detect a significant result. 

One noteworthy problem that arose during the analysis was the placement of the tree 

trunks in the photos taken at the ELGs.  Many trees were not quite centered enough, and 

therefore each photo had to be manipulated further to center the tree trunks and so future 

researchers might benefit from a camera that has grid marks in the viewfinder to better center 

each photo.   However, I reduced this source of error since each photo was manipulated in the lab 

in such a way that it was perfectly centered.    Using the coordinates of the tree trunk, the photo 

was properly centered, however future researchers might benefit from avoiding manipulating the 

photos.  

There were also background trees that had to be deleted from the image using ImageJ so 

that accurate analyses could be conducted.  Hackenberg et al., (2014) proposed a terrestrial laser 

scanning technique to study carbon stocks in forest that that allows for the 3-D mapping of tree 

biomass, which could perhaps be employed for studying crown architecture.  The researchers 

mapped out the branching structure of trees.   The technology used, the terrestrial LiDAR 

method, uses 3D laser pointers to estimate tree mass and volume with over 90% accuracy (Fig. 

7).  One possibility for future research might be to use this technique to measure tree crowns as it 

has been used in other studies to measure tree mass.  Instead of taking photographs of the tree 

crowns, the scanning technique could be used and the crown biomass weight of the tree crown 

could be measured and used for analyses such as this study. 
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Figure 7. Representation of terrestrial laser scanning technique that uses laser points to 
estimate tree mass.  Photo taken from https://www.ucl.ac.uk/news/news-articles/1114/211114-
laser-scanning-weighs-trees 

 

The photo on the right in Figure 7 is identical to the manipulated photos that were taken 

and converted to binary.  The LiDAR method would eliminate all the extraneous noise that I had 

to erase out of the background of my photos and would measure the mass of the trees, omitting 

any surrounding tree mass, making the analyses more accurate.  

Subcanopy trees, which are in the shade of light saturated canopy trees, will grow to 

displace their crown towards a newly created gap, since trees that are not light saturated will 

respond more to a sudden increase in light (Sterck & Bongers, 2001).  Young and Hubbell 

(1991) reported that only trees that were less than 23 m tall in a moist tropical forest in Panama 

responded to a gap by growing their crown asymmetrically.  Subcanopy trees have more to gain 

from the gap than canopy trees do as they experience intermittent light exposure and will allocate 

their resources in order to reach more light.  Aiba and Kohyama (1997) and Muth and Bazzaz 

(2002) reported that the crowns of shorter trees were more likely to be more displaced away from 

their trunk axes than taller trees.  Although my study did not look at subcanopy trees, it might be 

an interesting analysis for future researchers to compare crown asymmetry between canopy and 
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subcanopy trees.  Using another method of analyzing subcanopy trees might prove helpful, such 

as the previously mentioned LiDAR, as I did not include subcanopy trees because the 

background noise behind the subcanopy trees in the photos was too difficult to manipulate and 

remain biased.       

Plants are sessile organisms and must be able to alter their morphology and physiology in 

response to changing light conditions as they are bound to one location (Gratini, 2014).  

Phenotypic plasticity refers to organisms possessing the same genotype that express different 

phenotypes, physiologically and morphology, due to differing environmental cues (Whitman & 

Agrawal, 2009).  Shade tolerance in response to a gap is an example of such a phenomenon.  

Variation in shade tolerance level is correlated with phenotypic plasticity, and therefore shade 

tolerant trees will alter their crown architecture differently than shade intolerant trees in response 

to a sudden increase in light (Valladares & Niinemets, 2008).  While trees may be categorized 

into shade tolerant or shade intolerant groups for simplicity, shade tolerance is affected by 

abiotic or biotic factors, developmental stage, and plasticity (Canham, 1989; Gratani, 2014; 

Valladares & Niinemets, 2008).   Trees that are more plastic have a higher enzyme turnover rate 

than those that are less plastic, leading to a higher respiration rate, which is essential for the 

growth and maintenance of plant tissues (Canham 1989; Gonzales-Meler, Taneva, & Trueman, 

2004).  This turnover may alter the crown structure of trees due to their differences in 

photosynthetic utilization.  Shade tolerant trees, when in full sunlight, have generally denser 

crowns than those of shade intolerant trees.  However, in low light, shade tolerant trees possess 

wide, thin canopies, which is ideal for maximizing light interception in the understory.  It has 

been hypothesized that there is a trade-off between plasticity and survival of a tree in low light 

(Canham, 1989).  There is controversy regarding the relationship between shade tolerance and 

phenotypic plasticity.  Some studies gave evidence to support that shade intolerant tree species 
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are more plastic (Muth & Bazzaz, 2000; Longuetaud et al., 2013; Strauss-Debenedetti & Bazzaz, 

1991), so phenotypic plasticity must be considered when researching shade tolerance in response 

to environmental cues.    

One such environmental cue, light, plays a role in forest fragmentation and how the 

forests on Earth are going to look like in the future.  Secondary succession is a series of 

community changes that take place on a damaged habitat following events like forest 

fragmentation or deforestation, which are both current issues regarding forests. The tree species 

that will survive and reproduce will be those that are able to alter crown architecture, which will 

result in a shift in species dynamics over time as the tree species.  It is important to know how 

shade tolerant and shade intolerant trees will respond to forest fragmentation if we are to 

determine the state of forests in years to come.  Changes in plant species influences the micro-

organism, fungi, and animal species found in forests, and this in turn determines the herbivore 

and carnivore species that inhabit these forests.  One study has indicated that A. rubrum, a 

‘supergeneralist’ species, has been able to outcompete species like pines and oaks, due to its 

ability to successfully cope with rapid climate change and forest fragmentation. It has been 

hypothesized that forests will be dominated by species such as maples following secondary 

succession (Abrams, 1998).  Since this tree species populates forests in New England, it is 

reasonable to assume future forests will be dominated by maples.    

My study was based on one snapshot in time, and therefore its conclusions are restricted 

as they do not take into account the growth of tree crowns since the gap was produced.  I found 

in my study that crown architecture for some select trees was not asymmetrical towards the gap 

or was even asymmetrical towards the forest.  In order to make meaningful conclusions about 

crown architecture, temporal data should be acquired from when the gap was created until 2017, 
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so as to accurately track the possible changes of a tree crown over time. Future studies should 

also be conducted at the Yale -Myers Forest, to measure the growth of trees at a later point to see 

if crown asymmetry was delayed. Crown architecture is altered through normal tree growth and 

development, so conducting a study on one snapshot in time omits all associated variables, such 

as plasticity, which is a key feature in shade tolerance response to light (Valladares and 

Niinemets, 2008).  It is difficult to make meaningful conclusions about the plasticity of tree 

crowns at the Yale-Myers Forest as their architecture has not been studied soon after the creation 

of the gap, and doing a time-series analysis would allow researchers to study the dynamics of 

crown response to a gap over time.  Observing the growth of the canopy trees over time would 

help by both elucidating why some of these trees did not respond to the gap as expected in this 

study.  With this study, I had hoped to contribute to resolving the lack of agreement among past 

studies, however future studies exploring crown architecture should be conducted at the Yale-

Myers Experimental Forest to increase the significance of the study in the field of Forest 

Ecology.   
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Appendix A 

Cutting the image in half using ImageJ 

First method  

Plugins > Macro > Run Macro: Type in: 

 makeRectangle (0,0, getWidth()/2,getHeight()); 

 run(“Copy”); 

 run(“MakeInverse”); 

 run(“Crop”); 

run(“InternalClipboard”); 

> Create > Macros > Run Macro  

Second method  

The photos are made up of pixels with x and y coordinates.  Running the curser over each 

gives a location in x and y.  Therefore, holding the curser over the right and left bottom edges of 

the trunk base yielded two x coordinates (y was zero since they laid right on the x axis).  Adding 

these and dividing by 2 yielded the coordinate of the center of the trunk base.   

 Example method.  The two edges of the base of the trunk had coordinates (1250, 0) and 

(1650, 0).  The base of the tree trunk had coordinates (1450, 0).  Using the rectangular tool, the 

left side of the photo, starting at (0,0) and ending at (1450, 0) was cropped.  Since the right side 

had to have the same pixel dimensions, I added 1450+1450 to get 2900.  The right picture went 

from (1450,0) to (2900,0).  Any pixels after 2900 were not used.   
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Appendix B 

Methodology for computing the Mann-Whitney U test in SPSS 

In the data view, the histograms for the black values of each photo were inserted into each 

column, with heading: black-transect number-tree number-E for east or W for west.  Each 

column was given its own code column, north was given the code 0 and south was given the 

code 1.  These columns were described as analyze-transect number-tree number- E or W.   

 

Analyze > Nonparametric Tests > Legacy Dialogue> 2 Independent Samples >  

 Test variable list: black0301E 

 Grouping variable: analyze0301E 

 Test type: Check off Mann-Whitney U     >> click OK  

Sample SPSS output sheet: Saved as Kozey Road transect 3 spss manwhitneyu.sav  
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Appendix C 

Metadata (where on the Forest Ecology Lab computer are my files located) 

In: Forest Ecology Lab > Yale Forest Research > AB Original study adult trees > AB Kozey 

Road ELG > Photos > 2016 >  

> Kozoey Rd tree crown photos = all original tree crown photos  

> Kozoey Rd tree crown photos > ImageJ images =  

> Kozoey Rd tree crown photos > ImageJ images > SPSS analyses =   

Excel output sheets for each ELG were made.  The column headings for each transect were: tree 

number, distance form edge (m), species, DBH 2008, DBH 2016, Mann-whitney u value East, 

Mann-whitney u Z value East, Mann-whitney u value West, Mann-whitney u Z value West, 

significance value East, and significance value West.  The trees were ranked based on distance 

from the gap edge.    
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Appendix D 

Methodology for enlarging the pixel size of the photos 

In ImageJ:  image > adjust > size>  

  Width: 11 

  Height: 16     > ok 
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Appendix E 

 

Methodology for computing Kruskal-Wallis test in SPSS  

Analyze > Nonparametric Tests> Legacy Dialogue > K Independent samples 

 > Click Kruskal-Wallis H in Test Type 

 > Ok 
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Appendix F 

 

Methodology for computing regressions in SPSS 

Logistic regression  

Analyze > Regression > Binary logistic  

Linear regression  

Analyze > Regression > Linear  

 

	


